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                 M7CL 快速启动指南第3部分

第3部分
一本有关M7CL系列调音台包括第3版固件和M7CL-48ES硬件功能的介绍性指南。

快速启动指南
一本适合M7CL第3版的实际使用人员的指南。

本指南适合首次使用M7CL的人员，或需要一些
提示和技巧的有经验用户，以使他们更好地了
解M7CL及其基于PC的支持软件M7CL Editor。
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M7CL快速启动指南。

M7CL快速启动指南分成多个部分。可从www.yamahaproaudio.com网站的“Self Training”区域下载。同时提供修订的
M7CL快捷方式和提示列表。

第1部分介绍M7CL及其变型，并以具有类似功能的模拟调音台为基础说明该调音台的基本操作。

第2部分介绍仅数字调音台提供的额外功能；内部效果机架套件以及场景的基本使用以储存和调用参数。 

第3部分详细探讨场景记忆的使用以及基于PC/Mac的软件以便远程控制和设置；Studio Manager和M7CL Editor。

M7CL-48ES用户还应参阅雅马哈的EtherSound设置指南。该指南说明设计EtherSound网络的基本原则。  
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M7CL可储存300个场景记忆或快照。除300个有编号的记忆外，还有默认的只读场景000以及可能与场景相同或场景编辑
版的“当前调音台设置”。这些都保存在特殊缓冲存储器中，并且断电也不会丢失。  

场景000为“R”只读型。进行
编辑时，出现黄色  。不能
保存至场景000。

当调音台参数编辑到希望保存的地步时，按下SCENE MEMORY上/下键选择新场景的编号位置。所选的编号会闪烁。无
需显示场景列表，您可在任意时刻进行此操作。

场景管理和其他记忆功能。
M7CL能够记住所有混音参数，如EQ、动态和衰减器电平。这些记忆被储存在“快照”或“场景”中。相当于在模拟调
音台上用熟悉的圆形印纸“标记”台面。此“场景”表示所有参数在该特定时间点的 佳位置。如果试音和排练时间允
许，可为各歌曲或演奏节目（包括表演前进场音乐和表演后退场音乐）创建场景快照以及为各辅助节目创建场景。 

但请牢记，实况表演混音是项动态活动，一系列的场景调用无法始终应付意外的表演变化，或对观众引起的场内声音变
化作出反应。本指南介绍了如何利用场景快照系统的优势，同时使用Recall Safe和Recall Focus功能保持灵活性并对演出
进行动态混音。

除场景信息外，M7CL还能记住EQ、GEQ和动态资料库等便捷的参数信息资料库以及转接信息、用户自定义键和其
他首选项等设置功能。所有这些记忆共同组成了一个“会话”或“调音台”文件，使用USB存储设备或雅马哈Studio 
Manager可轻松将这些文件复制到另一调音台。M7CL只能包含单个“控制台”或“会话”文件，但通过连接运行Studio 
Manager和M7CL Editor软件的PC，可从一个会话中提取场景并合并到另一会话中。

SCENE LIST弹出窗口。

若要查看SCENE LIST弹出窗
口，请按下屏幕上的场景区
域。

如何储存场景
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要调用场景，请使用上/下箭头键查找其编号，然后按下
RECALL键。台面将重置为所选场景。不能调用未储存数
据的“空场景”。如果希望从全新的台面开始，则选择场
景000。

按下STORE（屏幕上或台面上），然后按下确认框中的
OK即可储存场景。功能访问面板中显示的场景编号和  
消失直至进行另一台面更改。
为了快速储存场景，可在SETUP首选项中禁用确认。这样
只需双击STORE键即可用当前场景名称储存。您可在稍后
更新场景名称。

使用CLEAR键清除现有的名称(Initial Data)。如果需要，则输入场景名称和注释。场景在创建时始终会被赋予一个自动
时间标记，该标记出现在SCENE LIST中。

如何调用场景。

撤销选项。
如果在储存或调用场景后意识到自己操作失误，也许调用
了所有通道均消音的场景或改写了一个重要的场景，则可
以“撤销”一步操作。可通过SCENE LIST弹出窗口执行此
操作。“撤销”会保留到下次储存或调用为止。
可将用户自定义键直接赋予“撤销储存”或“撤销调
用”的功能。

接着按下STORE键，SCENE STORE键盘弹出窗口将会出现。可在此给场景命名并为注释或长场景名提供了额外空间。
如果储存位置包含先前已储存的场景，则此场景会丢失。（但请参阅“撤销选项”部分。）可锁定场景以防丢失，但通
常情况下，请注意选择没有场景的位置以免改写重要的场景。
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管理场景列表

场景出现在位置编号旁的列表中。列表上面为剪切、复
制、粘贴和插入选项按钮，因此可重新排列场景列表的顺
序。也可用来清除不用的场景。必须要明白的是，用来存
入场景的场景编号只是一个位置而不是场景名称的一部
分。如果剪切和粘贴场景，场景将会改变编号。

有一个用于场景管理选项的“撤销”按钮，但该按钮只可
返回一步操作。

编辑单个场景
通过调用场景、进行必要的更改然后重新储存至相同的位置，即可完成对场景信息的编辑。
也可在离线PC上用Studio Manager M7CL Editor打开会话或场景然后进行更改。按下挂锁图
标栏中的灰色方块即可锁定场景以防被改写。场景000为只读型，无法被改写。

编辑多个场景；Global Paste
当您需要对多个场景进行相同的编辑时，使用Global Paste会很方便。典型的例子是当乐师更换乐器（如新贝司吉他）
时，技师需要在有新贝司演奏的所有场景中更改EQ设置。
通过SCENE LIST屏幕上的标签访问Global Paste弹出窗口。

提示；提示；如果您使用上/下键移动至新的场景编号，但又改
变主意不准备调用场景，则同时按下上/下键即可返回至
当前的场景编号。
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限制场景调用的效果。
场景调用是一个极其强大的功能，能帮助声音技师快速切换调音台的歌曲或场景。但很多情况下技师需要作出部分更
改，而不希望进行其他更改。M7CL有两种方案来限制场景调用；Recall Safe和Focus。

Recall Safe和Focus。
场景储存时，无论任何保护设置如何，均会记录所有通道的全部参数，但调用已应用Recall Safe或Focus设置的场景时，
待调用通道的特定参数会受到应用设置的限制且该参数在调用前后保持不变。Recall Safe可应用至整个通道，或作为
Partial Recall Safe应用至各个参数。
Recall Safe会影响所有场景中的参数，而Focus仅在调用特定场景时影响参数。有关对Recall Safe功能更深入的了解，请
查阅可从www.yamahapraudio.com网站上Self Training页面下载的“M7CLV3 Recall Safe Guide”。

Recall Safe；典型使用示例。
1. 如果要将一个特定的通道加入由许多场景组成的现有表演中。这可能是主持人麦克风或安全公告麦克风。
每次调用场景时，此麦克风通道均会“消失”，因为它并非新调用场景的组成部分。通过将麦克风通道置于“Recall 
Safe”中，场景调用就不会影响该通道，麦克风也会像场景调用前一样继续保留。
2. 另一个常用例子是在乐队演出中为每首歌曲应用一个场景。演播第一首歌曲时，技师通过改变EQ改善低音鼓的
音效。开始演播第二首歌曲时，低音鼓EQ会调用初始EQ而技师必须重复进行更改。随着更多通道被更改，这种工作量
会在整个演出中不断累积。使用“部分调用保护”，仅那些通道的EQ可从场景调用中删除，这样即使更改了衰减器电
平、发送、开/关等设置，该部分通道的EQ会保持不变。
3. 可对GEQ和机架设置进行调用保护。这非常有用，当歌曲二开始时，歌曲一中所应用任何系统或监听GEQ不会
被撤销。

Global Paste弹出窗口是一个功能强大而界面复杂的屏幕；
需要注意三个主要区域；
1. 从底部的标签中选择您希望编辑的某类参数。输
入、输出、机架或转接。
2. 选择您希望编辑的参数和通道。（在示例中，仅
限于贝司吉他的EQ。）
3. 选择要编辑的场景范围；开始处和结束处。

11

3322

此Global Paste屏幕显示了用于编辑场景2至8中所有通道9
（贝司）的EQ的设置。

PASTE；按下[PASTE]按钮时，所选通道的所有选定参数
均会变为台面上当前场景的位置。
所有选定场景均会拥有新的贝司EQ。

11

22
33

提示；提示；如果列表中的某一场景无需编辑（例如仍使用旧
贝司），则应使用挂锁符号锁定该场景以防止编辑。
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应用Recall Safe；
Recall Safe弹出窗口位于Channel Job区域。按下屏幕上的CH JOB区域，然后选择RECALL SAFE，即会出现弹出窗口。

可通过此屏幕应用Recall Safe并选择保护参数。  
若要应用保护，请选择通道以在弹出窗口的下部显示其
设置。选择要保护的参数（如ALL或HA和EQ）。通过
SAFE按钮开启保护功能。使用如上所示框图中的SET BY 
SEL功能可对多个通道快速应用此设置。

所有参数均受保护的通道会显示为绿色。部分保护的通道
显示为蓝色。虽然存在多种部分保护组合，但均显示为蓝
色。

打开和关闭保护
通过选择通道视图可打开和关闭保护功能，还有打开
RECALL SAFE MODE弹出窗口的快捷方式。如果保护设
为部分设置，则会在此指明，且即使选择关闭，部分设置
仍会保留。

通过从RECALL SAFE MODE弹出窗口的SAFE PARAMETER SELECT部分选择除CH ON以外的所有按钮，然后应用
至所有通道，即可轻松创建消音场景。在这种情况下，各场景将只能操作通道ON/OFF参数。同时点选以保护所有的
RACK、NAME和PATCH框。

注；注；[ALL]和所有参数按钮一起之间是有区别的。请注意有例外，即ON/OFF键也可调用通道链接、MIX/MATRIX总
线设置、TO STEREO/MONO、PAN/BAL、LCR和MUTE/DCA分配，因为这些参数要么不受参数保护影响（始终调
用），要么只能通过ALL进行保护。有关对Recall Safe功能更深入的了解，请查阅可从www.yamahapraudio.com网站上
Self Training页面下载的“M7CLV3 Recall Safe Guide”。
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按下场景列表下面的[FOCUS]标签可从SCENE LIST弹出窗口中进入聚焦屏幕。必须明白Focus和Recall Safe是不同的；
Recall Safe是对所有场景通用，Focus对特定场景专用。两者可选择的参数也是不同的。

Focus（或Recall Focus）；典型使用示例；

Focus是在调用所选场景时限制调用信息量的另一种方法。

1. 多乐队演出。在多乐队轮流演出中，各技师希望使用自己的GEQ设置，但他们又希望能作些更改而不被场景调
用“撤销”。因为Focus以具体场景为依据，所以可实现此功能。使用Focus从除各乐队演出的首个场景 以外的所有场景
调用中删除RACK。这样GEQ设置仅在新乐队开始演出时才会更改。
2. 转接更改。在实况记录设置中，需要将麦克风连接至场景通道进行记录，而使用相同的场景进行播放并连接录
音机。通过调用“记录设置”场景可将麦克风转接至通道，或通过调用“播放设置”场景可将录音机转接至通道。使用
Focus从实际场景的场景调用中删除INPUT PATCH，但在两个特别“设置”场景的Focus内保留INPUT PATCH。

如何限制场景调用；总结。

通过Focus。
在SCENE LIST弹出窗口中设置并储存各场景。

机架
预设效果和参数，但不包括转接。
HA
前置放大器，电平、+48V、Ø
输入转接
输入转接、插入转接、直接输出转接，但不包括开/关
输出转接
输出转接、串联转接。
IN 
输入通道参数；名称/图标、EQ+ATT、动态、消音和
DCA组设置、开/关、相移/平衡、衰减器。插入和直接
开/关。 
OUT 
输出通道参数；EQ、动态、开/关、衰减器和With Send设
置（如果按下）。
（带发送）
ON/OFF以及混音和矩阵发送的发送电平设置。

通过Recall Safe。
在RECALL SAFE MODE弹出窗口中设置所有
场景。

通用调用保护
输入转接、输入名称。
输出转接、输出名称。
单个机架单元1至8。

输入通道
以下所有参数或部分保护菜单；
HA、EQ+ATT、动态1、动态2、混音开、混音发送、矩
阵开、矩阵发送、衰减器、开/关。
立体声/非立体声主输出通道
以下所有参数或部分保护菜单；
EQ、动态、矩阵开、矩阵发送、衰减器、开/关。
混音主输出通道
以下所有参数或部分保护菜单；
EQ、动态、矩阵开、矩阵发送、衰减器、开/关。带混音
发送。
矩阵主输出通道
以下所有参数或部分保护菜单；
EQ、动态、衰减器、开/关。带矩阵发送。
DCA组
以下所有参数或部分保护菜单；
电平/开



9

                 M7CL 快速启动指南第3部分

保存和加载数据。
储存和调用与调音台文件内场景相关的操作。与从调音台添加或复制文件相关的保存和加载操作。调音台文件由各种
资料库组成，但这些均链接在一起，因此可通过一个简单文件一并进行保存或加载。这些文件对M7CL 32/48和M7CL-
48ES通用，但不与其他调音台通用。
除场景记忆（包括转接场景）外，调音台还会记住场景所不包括的各种调音台设置和首选项。
所有这些信息均可备份至普通USB存储设备。

场景包括哪些内容？
储存场景时，知道场景中包括什么内容以及哪些能通过场景调用进行更改是非常有用的。但是，只是场景调用未记录的
内容，并不表示这些内容在电源关闭时也不记录或不包括在整个调音台文件中。
下面的文本框清楚地说明了场景记忆中储存了什么内容，未储存什么内容。

包括在场景调用中。
前置放大器（电平、+48V、Ø）
外部前置放大器（端口、电平、+48V）
场景注释、时间标记
名称/图标
转接/通路（输入、输出、插入、直接、监听、串联、机
架）
插入（开/关、位置）
直接输出（开/关、位置、电平）
EQ（所有参数，包括HPF）
ATT（数字衰减器）
动态1（所有参数）
动态2（所有参数）
矩阵电平、开/关。
矩阵发送（总线设置、开/关、电平、前/后、相移）
混音发送（总线设置、开/关、电平、前/后、相移）
相移/平衡（位置立体声/非立体声/LCR）
DCA（分配、电平、消音）
消音组（分配、开/关）
衰减器和开/关
机架（所有参数）
后部面板对讲通路输入（和MONITOR屏幕中的电平）
聚焦
交叉淡变（开、时间）
通道链接设置
至立体声/非立体声（开、前/后）
串联转接

不包括在场景调用中。
但所有场景仍会记住

用户自定义键
首选项
亮度控制
OUTPORT延迟和电平设置
MIDI设置
字时钟
主+48V
CUE弹出窗口；PFL输入调整、DCA调谐、PFL输出调整   
监听弹出窗口；（电平、源打开/关闭、非立体声、链
接）
振荡器（所有参数）
保护分配（消音、调用）
密码/管理员/访客设置
屏幕页面或弹出窗口
所选的sends on fader
计量点选择
外部HA至插槽分配和HPF。
用户访问等级
网络设置
时钟！！
插槽和MY卡设置
用户资料库
 EQ/HPF，（用户和ROM）
 动态（非键盘输入），（用户和ROM）
 GEQ，（仅用户）
 效果（用户和ROM）

雅马哈并不制造和销售USB存储设备，但在计算机
和电子商店中很容易购得众多厂家生产的USB存
储设备。选择存储设备时请牢记；M7CL兼容
USB1.1，因此USB1.1和USB2.0均可使用。存储容
量不可超过16 G。可将驱动器格式化为FAT12、
FAT16或FAT32，但不可进行分区。您可在M7CL上
格式化新的驱动器，但请记住，格式化旧的驱动器
会删除其所有的存储内容。大多数USB存储器设备
均可使用，但雅马哈在www.yamahapropaudio.com 
(Downloads>Technical Documents & Data> Utilities 
and Data> Mixers)上提供了一份经过测试的存储器
设备列表。
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在USB存储设备上保存为ALL 
DATA文件。
上述所有场景列表中的全部场景数据。
当前场景（SAVE时正在使用的场景）。
外部插槽分配HA
保护分配
工作时钟设置
CUE弹出窗口设置；PFL输入调整、DCA调谐、PFL输出
调整   
监听弹出设置；（电平、源打开/关闭、非立体声、链
接）
计量点选择
MIDI设置
输出端口设置（延迟和电平）
用户资料库
 EQ/HPF，（用户和ROM）
 动态（非键盘输入），（用户和ROM）
 GEQ，（仅用户）
 效果（用户和ROM）
用户访问等级
首选项
用户自定义键

将数据保存至USB存储设备。
可将M7CL调音台的场景和设置储存至外部USB存储设备。这可用于备份调音台的内部记忆以及将数据传送至其他地区
的另一调音台。将以其他版本打开在M7CL32/48或M7CL-48ES通道版本上建立的文件。
非常情况下，在装有MY16-ES64 EtherSound卡并使用SB168-ES外部舞台接口箱的M7CL32/48中所创建的文件，必须进
行“转换”以在不使用MY16-ES64卡的调音台中工作；即便是M7CL-48ES，也不例外。反向操作也需要“转换”。只需
按下[STAGE BOX DATA CONVERSION]按钮并根据屏幕提示操作即可。转换过程不会改变USB设备上的数据。
只需插入USB存储设备就会打开SAVE /LOAD弹出窗口屏幕。
如果您的记忆棒已连接，则可通过功能访问面板的SETUP进入SAVE/LOAD弹出菜单然后按下SAVE /LOAD。

按下SAVE按钮将会导致ALL DATA保存。文本框说明了数
据文件中包含的内容。

保存在用户鉴定密钥上。

用户访问等级
首选项
用户自定义键

您还可通过此页访问CREATE USER KEY弹出窗口。除管
理员设置的用户访问权限外，该键能储存您的首选项和用
户自定义键设置。因此当您开始新的项目时，此功能非常
适用于将用户自定义键和首选项转移到另一调音台。

将数据从USB存储设备加载至调音台。
当将ALL DATA文件载入M7CL时，会改写调音台中的所有数据。（极少数项目除外，如以下文本框中的密码。）同
样，如果仅加载LIB场景文件，则会改写所有的现有场景，但会保留用户自定义键等设置数据。LIB文件将在稍后说明。
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电源关闭时在调音台中记录但不在
ALL DATA文件中。
密码
屏幕页面
亮度控制
网络设置
时钟（时间/日期等）

不会储存在任何地方！
屏幕页面弹出窗口。（但可制作书签）对讲开，
提示开（电源打开时始终为关）
OSC开（电源打开时始终为关）
监听衰减器开（电源打开时始终为关）
调音台锁（电源打开时始终为关）
监听、对讲和耳机旋钮（但不得在运输时移位！）

其他记忆数据。
某些内容会被调音台记录但不包括在ALL DATA文件中。有些内容则完全不被调音台所记录。

M7CL调音台文件的管理。
在SAVE/LOAD屏幕中，可对USB存储设备上的项目进行COPY、PASTE和DELETE，无论文件类型如何。
但只有某些类型的文件可载入M7CL。M7CL上仅可创建ALL DATA和USER KEY文件，但Studio Manager M7CL Editor可
保存Scene Only数据。还需识别固件文件和帮助菜单文件。请参阅以下指南。

M7CL文件。 
All.M7C  这是一种ALL DATA调音台设置文件，包含第8页
文本框中所列的全部信息。
可在调音台或M7CL Editor中创建All.M7C文件，这些文件
可用于在调音台和编辑器之间传送数据。
User Key.M7U  这是用户鉴定密钥，携带第8页上所列的用
户首选项和访问信息。
可在调音台或编辑器上创建、查看和编辑用户访问权限，
但只有调音台可查看和编辑首选项以及用户自定义键。
LIB.M7C 这是在Studio Manager中创建的“scene-only”数
据文件。不包含其他非场景可调用数据，如用户自定义键
或EQ等资料库。

Firmware.PGM 文件。调音台固件由四种不同的.PGM文
件组成（实际上两种用于M7CL32/48而另两种用于M7CL-
48ES，但它们始终是同时下载而调音台仅加载所需要的
文件），在电源打开时自行加载。（带确认对话框弹出窗
口）无法从SAVE/LOAD屏幕进行加载。

M7CL_EN.XML  共有多种不同语言的[Help]文件，必须从
保存/加载屏幕进行加载。 

name.YSE  这是以Yamaha Studio Editor格式创建和储存的
会话文件，无法在调音台中打开，只能在编辑器中打开。

New.M7C  新版本Studio Manager所保存的会话在旧调音台
固件上显示为“New”。请更新固件以便存取这类文件。

注；注；M7C文件有两种类型；ALL和LIB。

文件如何出现在MS Windows中。

文件如何出现在M7CL中。
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STUDIO MANAGER和M7CLV3 EDITOR。

Studio Manager 的背景和简介。

M7CL并不针对任何类型的演播室活动；它主要是一部实况音乐会转播调音台，因此许多人因其远程控制和编辑软件的
Studio Manager名称而产生误解。事实上，Studio Manager和M7CLV3编辑器非常适用于实况声音技师的需求；可在远离
调音台的PC上打开M7CL文件并进行编辑、保存和复制。文件都很小可通过电子邮件发送，还可将不同演出的场景合并
创建新的文件， 并且可在任意两个场景之间进行无缝切换。

Studio Manager这一名称来源于该软件更广泛的应用能力——可与演播室环境中的许多其他数字音频产品结合使用。
Studio Manager不仅仅限于远程控制一台M7CL，还能远程控制多台M7CL、其他雅马哈数字调音台、SPX2000效果器和
Motif键盘。反过来，Studio Manager可以成为Steinberg Cubase DAW设置的一部分，可在用DAW打开的单个文件中保存
这些产品的所有设置。

当然，其广泛的功能性与对M7CL进行简单的远程控制和编辑无关，但现在了解一些背景知识很有必要，以便今后需要
时明白如何在主副混用或串联配置下使用多台调音台的设置情况下保存文件。

Studio Manager

SPX2000

DM2000

MOTIF ES6/7/8

MOTIF ES6/7/8 Multi Part Editor

DM2000 Editor

SPX2000 Editor

Studio Manager

Studio Manager

DAW
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Studio Manager 和 M7CLV3 Editor 的作用是什么？

Studio Manager 和 M7CLV3 Editor 的结合软件能使您在个人计算机（PC 或 Mac）上创建和编辑 .M7 文件。这些文件记

录了某一设置中所有场景的全部参数数据，并且可使用 USB 密钥盘传送至调音台。亦可通过 DME-N Network 驱动程序

(PC) 或 Network MIDI 驱动程序 (Mac) 和 Cat5 交叉电缆连接，在“联机”模式下使用 Studio Manager 和 M7CL Editor 对

M7CL 调音台进行远程控制和监听，或在计算机和调音台记忆之间直接交换数据。

M7CL 并非必须配合 Studio Manager 使用；调音台无需任何外部计算机设备就能提供其所有功能，但 Studio Manager 增

加了非常有用的额外访问途径。您无需访问调音台就能在个人计算机上完成命名通道、转接 I/O、设置效果装置和参数

等准备事宜；不管是在家里还是公共汽车上，甚至在飞机上。其次，在连接 M7CL 时 Studio Manager 可提供另一种界面，

给出带有额外控制界面的不同视图，可供两名操作员使用并可使用平板 PC 进行远程控制甚至无线控制。

从哪里可以获得 Studio Manager ？
可从以下网址免费下载 Studio Manager 和各种编辑器程序；

 www.yamahaproaudio.com 
从 DOWNLOADS 页面找到 FIRMWARE AND SOFTWARE。

应该为 M7CL 下载三个软件；

1. Studio Manager V2 Host（PC 或 Mac）

2. M7CLV3 Editor（PC 或 Mac）

3. DME-N Network driver(PC) 或 Network MIDI driver(Mac)。

从 www.yamahaproaudio.com 下载的都是 新的版本且相互兼容并兼容 新的调音台固件。旧版本的 Studio Manager 可

能无法与 新的调音台版本通信，所以 好从网上下载而不要依赖随调音台附带或租借的 CD。因软件持续开发而导致

的任何额外限制均会在网站上进行说明。

目前可免费下载 Studio Manager 软件，但请牢记需要勾选“Licence Agreement”（许可协议）且您只能在协议条款和条件

允许的范围内使用该软件。

注；注；M7CLV3 Editor 可在 Studio Manager V2 Host 中工作。
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需要什么类型的计算机？

对于 Windows 7
CPU：1.4GHz 或以上的 Intel Core/Pentium/Celeron 系列处理器

操作系统：Windows 7（32 位、64 位；Ultimate / Professional / Home Premium）

硬盘：100 MB 或以上

内存：1GB 或以上（64 位为 2GB 或以上）

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

对于 Windows Vista
CPU：1.4GHz 或以上的 Intel Core/Pentium/Celeron 系列处理器

操作系统：Windows Vista（32 位；Ultimate/Enterprise/Business/Home Premium/Home 

Basic）

硬盘：100 MB 或以上

内存：1GB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

对于 Windows XP 
CPU：1 GHz 或以上的 Intel Core/Pentium/Celeron 系列处理器

操作系统：Windows XP Professional / XP Home Edition / XP Tablet PC Edition 2005 

硬盘：100 MB 或以上

内存：256 MB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

对于 Mac OSX
CPU：Intel Core 系列处理器

操作系统；Mac OS 10.5.8/10.6.x

硬盘；100MB 或以上

内存；1GB 或以上

显示器：1,024 x 768 像素或以上，高色彩 16 位或更高

我应该使用哪个固件和软件版本？

雅马哈在不断开发M7CL混音系统，有时会发布包含新功
能的新版本而有时新版本只是调整现有系统以改进性能
和“错误修正”。当发布新的调音台版本时，通常需要新
的Studio Manager和Editor版本以保持兼容性。   

调音台中保存的所有文件均为.M7C类型的文件且可在所
有未来调音台版本中打开，但是无法保证未来的文件仍会
与旧的调音台兼容。为此，雅马哈强烈建议在所有调音台
中使用当前的调音台固件。如果您拥有调音台，请使其保
持 新固件，否则来访技师可能无法打开他们的文件。如
果您是一位巡回自由技师，请携带 新的固件和升级用
USB密钥。调音台固件在www.yamahaproaudio.com上免费
提供。

雅马哈始终建议使用 新的调音台固件版本以及 新的Studio Manager和M7CLV3 Editor版本。该组合兼容联机连接和同
步，将具有 新的功能和 少的已知软件错误问题。但是，我们明白实际使用中旧的调音台版本仍在流行，技师们可能
已在旧的SM和Editor版本中保存数据。

该如何处理旧的版本？

系统要求会因未来更新而改变，在网站的下载页面上会给出当前信息，但在 2010 年秋季所有网络配备设备要求为；

此表是2010年10月的示例；
请从www.yamahaproaudio.com获取 新信息
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用Studio Manager保存的文件可具有其他格式（请参阅本指南的第11页）。如果用V1版的Studio Manager中将文件保
存为.YSM或.YSE文件，则无法在V2或V3中打开。为确保所有文件均可使用，www.yamahaproaudio.com的下载页面上
有三种版本的M7CL Editor供选择。这些涉及到以前的V1、V2和 新的V3版M7CL调音台固件。如果您现在拥有保存
为.YSM或.YSE型文件的V1 Editor文件，则需要使用V1版本的固件。 然后您可将这些文件重新保存为.M7C文件，即可
载入任意版本的调音台。如果调音台为V3版，则新保存的文件将更新至V3版，您可继续使用V3版的Studio Manager和
Editor。

安装软件。
可从下载页面下载完整的软件安装说明。安装向导会在整个安装过程中给您指导。除非您对安装目的地有特殊要求，否
则请使用默认设置。

如果没有 M7CL 的使用权，还能启动并使用软件吗？

能。一旦正确安装了Studio Manager软件，即可将它打开而无需调音台。但应明白M7CLV3 Editor图形与调音台中的不
同，因而研究M7CLV3 Editor并非了解实际调音台如何显示和工作的有效方法。 

Apple iPad用StageMix

M7CLV3的另一个远程控制器是用于Apple iPad和无线接
入点的StageMix。StageMix是为舞台声音技师在试音前和
试音过程中使用而设计的。它不包括混音调音台或Studio 
Manager的所有功能，只包括用于舞台混音的主要参数；
如Sends on Fader和EQ。（2010年11月中旬上市）

StageMix的优势是能够配合多点接触使用，专为无触笔、手指拖动和非常直观的iPad界面设计的。但StageMix只是一
个远程控制应用程序；不会记录数据且无法用于脱机编辑文件。StageMix和其他雅马哈iPad应用程序处于不断审核和
修订之中。可从普通的Apple Store地址免费下载并试用 新版本的StageMix。

完整的滑线电桥和衰减器视图 24 Mix/Matrix用Sends on Fader 拖动并挤压EQ曲线
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窗口大小可以调整，但内容无法缩放。  
如果您的屏幕不够大，则必须使用滚动条。

Editor打开时会显示INPUT CH 1-16窗口。

使用 Editor 窗口

M7CLV3

程序打开时，从File菜单选择Setup参数。使M7CLV3 Edi-
tor高亮显示并点击[Add->]将其移至工作区。如果您需要其
他编辑器用以打开旧的Studio Manager文件，则重复此步
骤。
当编辑器处于工作区时，应选中[Set Default]框，这样无需
在下次打开Studio Manager时进行此操作。

点击[OK]按钮，Studio Manager窗口会显示所选的编辑器。  

双击编辑器图标打开编辑器。

（如果您拥有多台调音台的复杂设置，您可左键双击图标
下面的名称逐个命名。）

首次打开 Studio Manager 和 Editor。
首次打开Studio Manager时需要完成一些设置事宜。

像任何其他程序一样打开 Studio Manager；
点击“开始”..............

提示；提示；对于类似INPUT CH 1-16的窗口，View标签会非常
有用。您可从显示屏中删除不使用的窗口部分，例如，
如果您不需要查看所有的Mix发送，则可将它隐藏起来从
而获得较小的窗口。这样无需滚动就能看到整个窗口，
并且有空间同时打开其他窗口。
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更改参数

使用您的计算机鼠标设置Editor窗口中显示的控制钮。  
例如；
点击并上下拖动衰减器。  
点击打开或关闭按钮。  
点击并顺时针或逆时针拖转旋钮。
双击dB数字值并输入数值。
双击名称（如Ch14）并重命名通道。 

使用Window标签按需要打开其他窗口。屏幕的分辨率越高，可安排的窗口就越多。

提示；提示；在Sends on Fader模式中，衰减器帽的颜色用以显
示所选的混音。灰色衰减器为已关闭的通道。（此视图
中的ON按钮表示Mix On而不是通道On。）

进入SENDS ON FADER模式并上下拖动混音发送值以设置
监听混音电平。从Sends on Fader窗口选择您的混音。
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SEL通道窗口；

主视图和附加视图

M7CLV3 Editor有两个SEL通道窗口；主视图和附加视图。两个视图看起来相同，不同之处在于如何选择所显示的通道。
还需注意，主视图可通过窗口内的按钮访问资料库，但这些按钮在附加视图中无法选择。

主视图通过[SEL]按钮来选择，而附加视图则通过使用箭头增加和减少通道来选择，或点击[Select]条从所产生的包括所
有通道的下拉框中进行选择。

目前，无论使用哪条SEL通道，主视图可能会更加方便，且具备资料库快捷方式，但以后联机连接调音台时，您可能要
决定需要Studio Manager显示与调音台相同的SEL通道还是不同的SEL通道。附加视图的实际用途是在联机时提供调音台
的辅助独立控制。

拖转旋钮。

若要设置旋钮的值，请点击并拖转旋钮。旋钮会像模拟旋
钮一样达到旋转终点。

拖出，然
后转动

提示；提示；为获得更高精度，可点击旋钮并沿圆半径拖出指
针，然后犹如转动具有该半径的大旋钮一样转动旋钮。
这在使用平板控制时尤其有用。亦可在旋钮上方的文本
框中输入数值。  
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File

Ctrl+N

Ctrl+O

Ctrl+S

Edit
Ctrl+Z

Ctrl+Y

Windows

Ctrl+W

Ctrl+Alt+W

Ctrl+T

Ctrl+Alt+T

Master Ctrl+1

Sends On Fader Ctrl+2

INPUT CH (CH1-16) Ctrl+Alt+1

INPUT CH (CH17-32) Ctrl+Alt+2

INPUT CH (CH33-48) Ctrl+Alt+3

ST IN Ctrl+Alt+4

MIX Ctrl+Alt+5

MATRIX Ctrl+Alt+6

STEREO/MONO Ctrl+Alt+7

DCA Ctrl+Alt+8

Selected Channel Ctrl+3

Library Ctrl+4

Patch Editor Ctrl+5

Rack Ctrl+6

Meter Ctrl+7

Group/Link Ctrl+8

Scene Ctrl+9

Synchronization Re-Synchronize Ctrl+0

Shift+

Ctrl+

Ctrl+A

Library Scene
SCENE MEMORY
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使用Studio Manager和M7CLV3 Editor进行场景管理。

在M7CL Editor上编辑调音台文件。
可使用M7CL编辑器打开储存在USB存储设备的调音台文件。通过“File>Open”和浏览“我的电脑”中的USB存储设备
可打开储存的会话。除非在文件名框下方的“Files of type;”框中选择调音台文件之前，否则仅显示.YSE文件。
Editor可用于更改大多数场景参数数据。特别要注意Editor无法用于更改以下文本框中的项目。

与M7CL Editor联机。
当通过Ethernet端口连接并使编辑器“联机”时即可控制M7CL调音台。用鼠标拖动控制钮会导致调音台参数、屏幕图
像以及衰减器变化和移动。请注意，除非完成了“RE SYNC”操作，否则Editor和M7CL不会显示相同的设置。当进
行“RE SYNC”时，会将各参数复制到其他设备，所以当面对Re-Synchronize对话框时务必作出正确的决定。
Console->PC或PC->Console。

通过Editor管理场景。
Editor会话与调音台会话一样，都包含300个场景。可通过MASTER窗口储存和调用场景，与调音台一样，可通过
SCENE窗口查看场景。

无法通过M7CL Editor进行设置。
（但仍可保存为.M7C、.YSM或.YSE文件）

首选项
OUTPORT延迟和电平设置
MIDI设置
字时钟
主+48V
CUE弹出窗口；PFL输入调整、DCA调谐、PFL输出调整   
监听弹出窗口；（电平、源打开/关闭、非立体声、链
接）
振荡器（所有参数）
用户访问等级

Scene窗口。

左侧为文件栏
右侧为内部数据栏

无法通过M7CL Editor进行设置。
（且不能保存为.M7C、.YSM或.YSE文件）

网络设置
时钟（天/日期等）
密码
亮度控制
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使用Scene窗口。
Scene窗口显示两栏。  
右手栏标题为“INTERNAL DATA”，此栏列出的场景构成ALL DATA会话文件的部分。可在软件上对它们进行编辑。
如果编辑器与调音台联机连接，则这些场景与调音台SCENE弹出窗口中显示的相同。调用一个场景将其显示在编辑器窗
口中，同时将其调用至调音台。
左手栏标题为“FILE”，此栏列出的场景为“scenes only”。它们不“包含”在ALL DATA文件中。一旦保存并传送至
USB存储设备，它们会在调音台的SAVE/LOAD页面中显示为LIB文件。  

要保存INTERNAL DATA场景列表，可进入FILE>Save Session并保存至计算机的存储器中。可将文件保存为.M7C文件，
以通过USB存储设备直接传送至调音台，或保存为.YSE文件可在编辑器上打开。调音台无法打开.YSE文件，但它有一个
小小的优势，即在M7CL Editor中打开时会记住窗口的布局。   
要保存场景的FILE列表，可使用列表上方的SAVE AS按钮。这也会使文件带有.M7C的扩展名，但并非ALL DATA文件，
只是场景而已。这些文件会在调音台的SAVE/LOAD弹出窗口中显示为LIB文件，可在调音台中打开，但始终是作为包含
300个场景的一个场景块，因此会丢失调音台内的所有场景数据。 

注；注；在此LIB加载的特例中不会改写当前场景。 
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示例；将储存的用户效果从某一会话加载到另一会话。

在本例中，让我们想象歌手“Guest”在舞台上加入“The Examples”。“Guest”需要特殊的延迟效果转接以适合他的

嗓音。特殊效果参数在不同的M7CLV3文件中。有两种方法进行传送；

1. 手动。打开Studio Manager和M7CLV3 Editor并查看“Guest”演出文件中的参数。然后将它们手动复制并储存到“The 

Examples”的演出文件中。如果仅一种效果，则可接受这种方法，但如果Guest要以不同效果演唱多首歌曲，则这种方法

会令人厌倦且容易出错。

2. 使用M7CLV3 Editor进行横向拖动。

在将Guest Delay FX从某一文件传送至另一文件之前，必须

将它储存在效果资料库中。使用M7CLV3 Editor，打开带

效果的场景，再打开Effect Editor窗口并将效果储存至资料

库。（Guest的技师可能已完成此操作。）

接着，将所储存的效果从右手栏(INTERNAL DATA)拖放到

左手栏(FILE)中，然后确认。无法选择小于056的资料库位

置，因为这些是用于雅马哈预设的ROM。

点击FILE栏上方的SAVE按钮保存新用户资料库。这会将

资料库作为.M7C文件保存至您的计算机。但是，请务必

明白这并非M7CL会话文件，而只是一个效果资料库。为

此，建议您将资料库命名为能够反映其内容的名称，因为

如果不这么做会很容易与其他.M7C文件混淆。

在本例中，我们选择“GuestFX”。

您无法将此资料库直接载入调音台，但您可将资料库条目

拖出并放入不同的会话文件中。  

关闭“Guest”会话并打开“The Examples”。打开Effect 

Library窗口。  

接着，使用FILE栏上方的Open按钮打开FILE侧

的“GuestFX”资料库。（可能自保存后仍然打开）。

将所储存的“Guest Delay FX”从FILE拖到INTERNAL 

DATA。选择一个空位置。

现在可在主乐队演出文件中使用Guset效果。

Library 窗口拖动功能。
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更多的 Library 窗口拖动功能。  
这一资料库窗口横向拖动项目的技巧也适用于其他资料库

项目。例如通道资料库项目；也许您希望将访客的通道设

置从他们的文件复制到您的文件中；可使用相同的技巧。

除资料库项目外，也可按此方法拖动场景，但要考虑到不

交替使用两个编辑器；这会跳过保存至PC的中间步骤。

除从INTERNAL DATA拖到FILE并保存为资料库文件外，

另一种方法就是打开两个M7CLV3 Editor。这种方法的优势

是可同时打开两个会话并将数据从一个会话横拖到另一会

话，无需经历中间的保存阶段。当一个编辑器与调音台联

机而另一个脱机时，这种方法特别有效。您可从脱机会话

拖出并直接释放到调音台！请特别注意不要使两个编辑器

同时与调音台联机，并对编辑器进行命名以免混淆！

使用两个 M7CLV3 Editor。

将两个乐队的场景合并入一个会话文件；
将场景从某一会话拖到另一会话（例如当两个乐队同台演出时合并两个乐队的会话）的过程为；
在Studio Manager中打开两个M7CLV3 Editor。（One和Two）
在一个编辑器内打开一个乐队的会话。
在两个会话中打开Scene窗口并重新调整所有窗口的大小，使您能够同时看到两者。
将所需的场景从Editor One拖至Editor Two。选择空的场景位置（可能是新的编号）。

现在可在乐队Two的会话中使用来自乐队One的场景。

后通过File>Save As保存此新的会
话，重命名并从.M7C或.YSE选择文件
类型。
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使用Focus和Recall Safe以确保按预期进行输出。

当类似此例将场景合并入相同会话时，应特别注意确认不会发生转接更改，导致过程无效的。例如，如果乐队A的输出
被转接至不同的Omni输出，则可能无法听到他们的声音！

小心使用从本指南学到的知识，可确保输出仍连通至正确的Omni输出并采用正确的处理方式。使用Recall Safe或Focus确
保这点。
可从M7CL编辑器或调音台的场景窗口设置Focus。使用Focus可从调用中删除输出转接，并按需要输出EQ和动态等输出
处理效果。不要应用“WITH SENDS”按钮，否则也会从调用中删除馈给至输出的发送电平。
此外，如果您希望使用其他技师（正在合并其会话）所设置的GEQ设置，可能会希望在RECALL SAFE屏幕中对某些
RACK GEQ进行防调用保护。
如果Recall Safe和Focus无法应付转接要求和更改，请牢记总可使用编辑器为旧场景创建新转接。

祝您好运并享受场景混音之乐！
www.yamahaproaudio.com
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